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Installation

INSTALLATION
Instal l ati on

This guide provides step-by-step instructions for installing the CCH® ProSystem fx®
Workpaper Manager Administrator and Workpaper Management modules. The minimum and
recommended system requirements are also provided.
Before you begin, refer to the following documents:
The License Agreement for information and restrictions on installation.
The CCH ProSystem fx Workpaper Manager Release Notes for new product features.
The Administrator/Office Server Tips document for assistance in determining how you should
configure office servers for your firm.
The Deployment Planning Guide for understanding how to properly set up and maintain your
environment.
Two CCH ProSystem fx Workpaper Manager modules must be installed in order for the application to
function. These modules are the Administrator module and the Workpaper Management module.
The Administrator module is an organizational tool designed to provide security and control rights for
different staff levels, as well as organize and maintain your office servers and central file rooms.
The Workpaper Management module relies on the Administrator module to provide login information,
central storage, and secured access to all your client data.

Note : If you are installing to a multi-server Citrix® farm or to a Windows® Terminal Services
environment, install CCH ProSystem fx Workpaper Manager Administrator in the standard
manner, and then see Terminal Services Installation on page 22.
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Workpaper Manager 2017 System Requirements
Administrator Module
System
Requirements

Recommended

Minimum
32-bit: Pentium ® 4 processor, 2
GHz
64-bit:

Microprocessor

64-bit multi-core processor

Pentium ® 4 processor,
3.2 GHz, or any multicore processor
AMD™ Athlon 64, Intel®
Pentium ® 4 with Intel®
EM 64T support

Microsoft ® Windows® 8.1, 32 and
64-bit
Microsoft ® Windows® 10, 32 and
64-bit
Microsoft ® Windows Server® 2012
R2

Microsoft ® Windows® 7,
SP 1
Microsoft ® Windows
Server® 2012 (64-bit)

Microsoft ® Windows Server® 2016

Important:

Supported
Operating
Systems

Microsoft ® Small Business Server®, Windows Server® Essentials, and
Windows Server® Foundation are not supported.
Installing Workpaper Manager on a server that is also a Domain
Controller is not supported.
Installing Workpaper Manager on a server that is also the firm's
Exchange Server is not supported.
Linux® is supported for workpaper storage only.
Microsoft ® Windows® 8.1 Pro and Enterprise Editions are supported.
Microsoft ® Windows® 8 is not supported; we recommend upgrading to
Windows® 8.1 or Windows® 10.
Microsoft ® Windows® 7 is supported; however, Microsoft ® ended
mainstream support for this operating system on January 13, 2015. We
recommend upgrading to Windows® 8.1 or Windows® 10 as soon as
possible.
All Microsoft ® Windows® Home Editions are not supported.
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System
Requirements

Recommended

32-bit: 2 GB RAM

4 to 8 GB RAM

System Memory

Minimum

64-bit: 4 GB RAM

Notes:
Additional memory improves performance and may be required to run
additional applications simultaneously.
Memory consumption varies based on usage of Microsoft ® SQL Server®.

Drive Space

Administrator requires approximately 405 MB of drive space when installed with
the CD image files, 3.5 GB of drive space in the Temp folder, and additional
space required for data.
Super VGA at 32-bit color quality with a resolution of 1024 x 768.

Video
CCH ProSystem fx Workpaper Manager does not support large fonts.
Network Environment
Microsoft ®

Client for Microsoft ® Networks and Microsoft ® TCP/IP.
Other Software
SQL Server® 2014, SP1
SQL Server® 2014 Standard Edition
(32-bit and 64-bit)
SQL Server® 2014 Business
Intelligence Edition (32-bit and 64bit)

SQL

SQL Server® 2014 Enterprise
Edition (32-bit and 64-bit)
SQL Server® 2016, SP1
SQL Server® 2016 Standard Edition
(64-bit)
SQL Server® 2016 Business
Intelligence Edition (64-bit)

SQL Server® 2012, SP2
SQL Server® 2012
Standard Edition (32-bit
and 64-bit)
SQL Server® 2012
Business Intelligence
Edition (32-bit and 64bit)
SQL Server® 2012
Enterprise Edition (32-bit
and 64-bit)

SQL Server® 2016 Enterprise
Edition (64-bit)
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System
Requirements

Recommended

Minimum

Notes:
If you need to set up SQL manually, see Appendix A: Installing SQL
Server® 2012 on page 28 , Appendix B: Installing SQL Server® 2014
on page 42, or Appendix C: Installing SQL Server® 2016 on page 54:
64-bit editions of SQL Server®
Standard Editions of SQL Server®
Enterprise Editions of SQL Server®
These sections describe how to set up SQL with Workpaper Manager
manually.
Depending on usage, Standard, Business Intelligence, or Enterprise
Edition of Microsoft ® SQL Server® may be necessary.
The following items are installed automatically with Workpaper Manager:
Microsoft ® Jet Database Engine 4.0 with Service Pack 6
Soap Toolkit 3.0
MSXML 6.0, SP1
SQLXML 4.0 SP1
Microsoft ® Visual C++® 2008 Redistributable x86 9.0.30729.17
Microsoft ® Visual C++® 2008 Redistributable x86 9.0.30729.4148
Microsoft ® Visual C++® 2010 Redistributable x86 10.0.40219
Data Access
Components

SQL Native Client 2008 (x86 for 32-bit; x64 for 64-bit)
The following items are installed automatically with CCH ProSystem fx
Workpaper Manager:
SQL 2016 CLR (x86 for both 32 and 64-bit), Admin only
SQL Server® 2016 Management Objects (SMO) (x86 for both 32-bit and
64-bit), Admin onl
Microsoft ® .NET Framework 4.6.1 Full is required by Workpaper Manager.
Adobe® Reader® 11 or DC.

Note : Adobe® Reader® 11 and DC are supported, but Workpaper Manager
workpapers must be opened with Reader's Protected Mode turned off

Web Browser

Microsoft ® Internet Explorer® 10 or higher.
Microsoft ® Edge
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System
Requirements

Email

Recommended
Microsoft ® Mail, Microsoft ® Exchange,
Internet SMTP/POP3, or other MAPI
compliant messaging software to use
network or Internet email

Minimum

None

Other Hardware
Internal or
External
Installation
Media drive, if
applicable

Any internal or external Installation Media compatible drive, if applicable for
reading the installation media.

Workpaper Management Module
System
Requirements

Recommended

Minimum
32-bit: Pentium ® 4 processor, 2
GHz
64-bit:

Microprocessor

Multi-core processor

Pentium ® 4 processor,
3.2 GHz (or any
multi-core processor)
AMD™ Athlon 64, Intel®
Pentium ® 4 with Intel®
EM 64T support
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System
Requirements

Recommended
Microsoft ® Windows® 8.1, 32 and
64-bit
Microsoft ® Windows®10, 32 and 64bit

Minimum

Microsoft ® Windows® 7,
SP 1

Notes:
Supported
Operating
Systems

Microsoft ® Windows® 8.1 Pro and Enterprise Editions are supported.
Microsoft ® Windows® 7 is supported; however, Microsoft ® ended
mainstream support for this operating system on January 13, 2015. We
recommend upgrading to Windows® 8.1 or Windows® 10 as soon as
possible.
Microsoft ® Windows® 8 is not supported; we recommend upgrading to
Windows® 8.1 or Windows® 10.
All Microsoft ® Windows® Home Editions are not supported.

System Memory

32-bit: 2 GB RAM

32-bit: 2 GB RAM

64-bit: 4 GB RAM

64-bit: 4 GB RAM

Notes:
Additional memory improves performance and may be required to run
additional applications simultaneously.
Memory consumption varies based on usage of Microsoft ® SQL Server®.

Drive Space

Video

Workpaper Management requires approximately 621 MB of drive space, 3.5 GB
of free space for the Temp folder during installation, and additional space
required for data.
Super VGA at 32-bit color quality with a resolution of 1024 x 768.

Note : CCH ProSystem fx Workpaper Manager does not support large fonts.
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System
Requirements

Recommended

Minimum

Other Software
Microsoft ® Office 365™ - Desktop
version

Microsoft ® Office 2013,
SP1, 32-bit and 64-bit

Microsoft ® Office 2016, 32-bit and
64-bit
Microsoft ®
Office

Notes:
Only Professional editions of
Microsoft ® Office are certified to
work with Workpaper Manager.
Microsoft ® Office 365™ Online
version is not supported.
Microsoft ® SQL Server® 2014
Express, SP1
Microsoft ® SQL Server® 2016

Microsoft ® SQL Server®
2012 Express, SP2

Express, SP1

Notes:
SQL

See Appendix A: Installing SQL Server® 2012 on page 28 , Appendix B:
Installing SQL Server® 2014 on page 42, or Appendix C: Installing SQL
Server® 2016 on page 54:
64-bit editions of SQL Server®
Standard Editions of SQL Server®
Enterprise Editions of SQL Server®
These sections describe how to set up SQL with Workpaper Manager manually.
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System
Requirements

Recommended

Minimum

The following items are installed automatically with CCH ProSystem fx
Workpaper Manager:
Microsoft ® Jet Database Engine 4.0 with Service Pack 6
Soap Toolkit 3.0
MSXML 6.0 SP1
SQLXML 4.0, SP 1 will be installed with Workpaper Management and
Terminal Services Database
Microsoft ® Visual C++® 2008 Redistributable x86 9.0.30729.17
Data Access
Components

Microsoft ® Visual C++® 2008 Redistributable x86 9.0.30729.4148
Microsoft ® Visual C++® 2010 Redistributable x86 10.0.40219
SQL Native Client 2008 (x86 for 32-bit; x64 for 64-bit)
Microsoft ® .NET Framework 4.6.1 is required by Workpaper Management.
If Office 2013 or 2016 is installed, the following item is installed automatically:
Visual Studio® Tools for the Office System 4.0 Runtime
Adobe® Reader® 11 or DC.

Note : Adobe® Reader® 11 and DC are supported, but Workpaper Manager
workpapers must be opened with Reader's Protected Mode turned off.

Web Browser

Email

Microsoft ® Internet Explorer® 10 or higher.
Microsoft ® Edge
Microsoft ® Mail, Microsoft ® Exchange,
Internet SMTP/POP3, or other MAPI
compliant messaging software to use
network or Internet email

None

Other Hardware
Internal or
External
Installation
Media drive, if
applicable

Any internal or external Installation Media compatible drive, if applicable for
reading the installation media.
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Terminal Services Client Module
System
Requirements

Recommended

Minimum

Number of
Peak Users

Varies based on hardware; maximum is 20 users per server.

Processor

64-bit multi-core processor
Microsoft ® Windows Server® 2012 R2
Microsoft ®Windows Server® 2016

Microsoft ® Windows
Server® 2012 64-bit

Important:
Supported
Operating
Systems

Microsoft ® Small Business Server®, Windows Server® Essentials, and
Windows® Server Foundation are not supported.
Installing Workpaper Manager on a server that is also a Domain Controller
is not supported.
Installing Workpaper Manager on a server that is also the firm's Exchange
Server is not supported.
Linux® is supported for workpaper storage only.
8 GB RAM or more

Memory

Note : Memory consumption varies based on usage. More memory may be
necessary for improved performance.
Microsoft ® Office 365™ - Desktop
version
Microsoft ® Office 2016, 32-bit and 64-bit

Microsoft®
Office

Microsoft ® Office
2013, SP1, 32-bit and
64-bit

Notes:
Only Professional editions of Microsoft ®
Office are certified to work with
Workpaper Manager.
Microsoft ® Office 365™ Online version is
not supported.

Citrix®

Citrix® XenApp® 7.7

Citrix® XenApp® 7.5

Citrix® XenApp® 7.12

Citrix® XenApp® 7.6
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Terminal Services Database Module
System
Requirements
Processor

Recommended

Minimum

64-bit multi-core processor
Microsoft ® Windows Server® 2012
R2
Microsoft ® Windows Server® 2016

Microsoft ® Windows
Server® 2012 64-bit

Important:
Supported
Operating
Systems

Microsoft ® Small Business Server®, Windows Server® Essentials, and
Windows Server® Foundation are not supported.
Installing Workpaper Manager on a server that is also a Domain Controller
is not supported.
Installing Workpaper Manager on a server that is also the firm's Exchange
Server is not supported.
Linux® is supported for workpaper storage only.
4 GB RAM or more

Memory

SQL

Note : Memory consumption varies based on usage. More memory may be
necessary for improved performance.
Microsoft ® SQL Server® 2014, SP1
(Standard. Enterprise, or Business
Intelligence)
Microsoft ® SQL Server® 2016 SP1
(Standard or Enterprise)

Microsoft ® SQL Server®
2012 Express
Microsoft ® SQL Server®
2012, SP2 (Standard or
Enterprise)

Note Regarding Adobe® Reader® 11 and DC
CCH ProSystem fx Workpaper Manager 2017 supports Adobe® Reader® 11 and DC.
The "Protected Mode" must be turned off in Acrobat ® Reader® to use Workpaper Manager
functionality, such as: tickmark definitions, workpaper notes, and workpaper references, By default,
"Protected Mode" is on. Workpaper Manager will detect this setting and prompt you to disable it.
If you select Yes, Protected Mode is turned off and the workpaper is opened with Workpaper
Manager functionality in place.
If you select No , the workpaper opens in Protected Mode, and Workpaper Manager functionality
is disabled.
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To manually set Adobe ® Acrobat ® Reader® 11 or DC to always open with Protected Mode turned off,
do the following:

1. Open Adobe ® Acrobat ® Reader® 11 or DC.
2. Select Edit > Preferences > General. (In Adobe ® Acrobat ® Reader® DC, select Edit >
Preferences > Security (Enhanced) ).
3. Uncheck the Enable Protected Mode at startup option.
4. Click OK.
5. Restart Adobe ® Acrobat ® Reader® 11 or DC.

Installation Considerations
We recommend that you update your video card driver to the latest driver available and install
Microsoft ® Direct X 9.x or higher.

Deployment Planning
Before installing CCH ProSystem fx Workpaper Manager, it is important to understand how to
properly set up and maintain the environment. The CCH ProSystem fx Workpaper Manager
Deployment Planning Guide, located in the Documents folder of the Installation Media, helps
administrators and managers identify the key factors that influence the performance, reliability, and
functionality of the CCH ProSystem fx Workpaper Manager application. The Deployment Planning
Guide can help you make key decisions regarding your necessary hardware capacity, data
distribution, Terminal Services, SQL servers®, and other issues.

Compressed Drives and/or Partitions
CCH ProSystem fx Workpaper Manager does not support the storage of workpapers or databases on
compressed drives, volumes, or partitions. CCH ProSystem fx Workpaper Manager uses SQL
Server® databases, and Microsoft ® has determined that having SQL Server® databases on
compressed volumes may cause performance and database recovery issues. Additionally, storing
Workpaper Manager databases and/or workpapers on compressed volumes may cause installation
failures, synchronization issues and data loss.
For Workpaper Management and/or Admin Module/Workpaper Management installations, the
CCH ProSystem fx Workpaper Manager 2017 installer will now automatically decompress any
compressed files found in Admin\Data, WM\Data, or TB\Data folders at the beginning of the upgrade
process.

Note : The automatic decompression of compressed files only occurs if there is enough space on
the drive to allow for decompression, which is typically a minimum of 100 MB.
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Alternatively, any compressed files in a user-specified bin location at the time of upgrade, which are
not in the locations previously mentioned, will also be checked. A log file will be written to X:\Pfx
Engagement\Common\PfxEngCompressedFiles.log (where X represents the drive where Workpaper
Manager is installed) listing the name and size of any compressed files found. For all other installs,
such as TSDatabase or stand-alone Admin, a log will be written to PfxEngCompressedFiles.log
naming any compressed files found. Due to potential size and time constraints, these files will need to
be manually decompressed using the CCH ProSystem fx Workpaper Manager Detect Compressed
Database Utility.
In addition, the CCH ProSystem fx Workpaper Manager, SQL 2016 Instance Installer, SQL 2014
Instance Installer and the CCH ProSystem fx Workpaper Manager SQL 2012 Instance Installer will
perform the same decompression process described above when upgrading.
For new installations of Workpaper Manager, please refer to the CCH ProSystem fx
Workpaper Manager Detect Compressed Database Utility to identify compressed database files
prior to installation. Additionally the utility will detect a Microsoft ® SQL Server® start-up parameter
that will prevent the SQL upgrade. This utility is located in the Utilities folder on the
CCH ProSystem fx Workpaper Manager Installation Media.
For more information on compressed drives, please see the following Microsoft ® Knowledge Base
article ID 231347:

https://support.microsoft.com/en-us/kb/231347.

Technical Considerations
For in-depth networking instructions and technical considerations, please see Appendix E: Technical
Considerations on page 69.
These appendices cover the following network issues:
Windows® and Linux® servers
LAN, WAN, and VPN topologies
Port configuration
Information on SQL services and memory usage
Communication across networks and subnets
Static versus dynamic IP addresses on office servers
These appendices also address the following topics in detail:
CCH ProSystem fx Workpaper Manager allows users to store their workpapers on a different
server than where the binder database is located (Office Server). In these cases, the
CCH ProSystem fx Workpaper Manager Synchronization service needs to be configured to run
under an account with rights to the location where the workpapers are being stored. The
workpapers can reside on a non-Windows® server.
For more information, see Appendix D: Installing Workpaper Manager with Active Directory®
on page 67.
Time synchronization plays an important part in CCH ProSystem fx Workpaper Manager. All
servers and workstations running Workpaper Manager (in the office and in the field) should
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maintain time clock synchronization to ensure that you do not lose data and to ensure that the
latest changes to data and server are properly synchronized. For more information, see Time
Synchronization on page 74.
Changing workstation or server names is not supported after CCH ProSystem fx
Workpaper Manager has been installed. This is due to the installation of SQL. See Appendix E:
Technical Considerations on page 69.
For additional information or for the latest update on any of these items, please contact
CCH ProSystem fx Technical Support.

CCH ProSystem fx Workpaper Manager Administrator Considerations
The CCH ProSystem fx Workpaper Manager Administrator module should be installed and
configured on a Windows server® or a dedicated computer with a Windows® operating system, as
noted above. If you plan to maintain multiple office servers, the Administrator module should be
installed and configured on a Windows server® or a dedicated computer for each office.
Administrator must be installed to a location For more information on office servers, please refer to
Chapter 3, Workpaper Manager Administrator, in the User Guide.
Administrator must be installed to a location accessible by all computers running CCH ProSystem fx
Workpaper Manager Workpaper Management. Administrator installation must be performed at the
console of the Windows server® or the dedicated computer. It cannot be installed by pushing the
install from another computer to the Windows server® or dedicated computer.
The CCH ProSystem fx Workpaper Manager Deployment Planning Guide, located in the
Documents folder of the Installation Media, helps administrators and managers identify the key
factors that influence the performance, reliability, and functionality of the CCH ProSystem fx
Workpaper Manager application.
The Administrator Workstation setup allows you to remotely access the Administrator module. The
Administrator Workstation can be installed to any workstation that needs to remotely access the
Administrator module.

Notes:
Workpaper Manager Administrator should not be installed on every computer in your firm.
Administrative rights are required to install the application to the local machine.

Important: Installing Workpaper Manager Administrator on a domain controller, Microsoft ®
Small Business Server®, Windows Server® Essentials, Windows Server® Foundation, or
Exchange Server are not supported.
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Pre-Installation Checklist
Before beginning the installation, verify that all of the following tasks are completed:
If you are upgrading to CCH ProSystem fx Workpaper Manager 2017 from a prior version, do
the following:

Back up the central databases. Perform a full back up of all central admin and bin
databases prior to upgrading. For detailed instructions on using the backup restore
utility, see Appendix F: Database Backup and Restore on page 77.
Back up the workpapers. Back up all workpapers before upgrading. To ensure that
this backup contains the latest versions of all files, users should synchronize all binders
to the Central File Room prior to the backup.
Note : The Database Backup and Restore utility does not back-up the workpapers.
You will need to use your own, third party, utility to back up your workpapers.
Back up templates. Back up all centrally located templates prior to upgrading to allow
for a full rollback if necessary.
Upgrade the main office server . We recommend that you upgrade the main office
server first, then upgrade the workstations in order of priority to begin using the software.
Important: All machines running Workpaper Manager in a network environment must be
on the same version of Workpaper Manager within the same office.
Close Microsoft ® Word, Excel®, and Outlook®.
We strongly recommend that you close any additional programs.
Disable virus-checking programs.
If you are installing on a computer that currently has another application using SQL, stop that
instance.

Note : Do not stop instances of SQL Server® (PROFXENGAGEMENT).
If the computer is already running Microsoft ® SQL Server® 2012, 2014, or 2016, Enterprise or
Standard Edition, we recommend that you continue to use that version and configure a named
instance of SQL Server® for CCH ProSystem fx Workpaper Manager prior to installation. This
allows CCH ProSystem fx Workpaper Manager to run optimally. If an Engagement SQL
Instance already exists on the computer, you do not need to install SQL again.
If the computer is not already running Microsoft ® SQL Server®, we recommend installing
Microsoft ® SQL Server® 2012, 2014, or SQL 2016 Enterprise, Standard Edition or Express
editions of SQL Server®.

Notes:
If you need to install the Standard or Enterprise Editions of SQL Server® see Appendix
A: Installing SQL Server® 2012 on page 28, Appendix B: Installing SQL Server® 2014
on page 42, or Appendix C: Installing SQL Server® 2016 on page 54.
SQL Express 2012, 2014, or 2016 installers are available on the Engagement Installation
Media. Choose only one of the installers. You do not need to install both.
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If SQL Agent is currently running on the system for any purpose, verify if “Local System Account”
is used as its Startup Account. If it is not, then follow the Pre- and Post-Installation Steps in
the SQL Agent chapter of the “Deployment Guide.”
Ensure that the operating system, Microsoft ® Internet Explorer®, and Microsoft ® Office are all
installed with the required service packs. See Workpaper Manager 2017 System Requirements
on page 2 for details.
Ensure that all Windows® updates have been installed.

Installation Instructions
This section provides standard procedures for installing or upgrading the Workpaper Manager
Administrator module and Workpaper Management module.

Warning! Publishing installation Group Policy Objects through Active Directory® is not
recommended due to possible conflicts among versions (for example, Canadian CCH
Engagement Administrator and United States Engagement Workpaper Management on the
same workstation).

Installing Workpaper Manager for the First Time
To install CCH ProSystem fx Workpaper Manager for the first time, do the following:

1. Complete all tasks in Pre-Installation Checklist on the previous page.
Notes: Administrative rights are required to install the application to the local machine.
2. If you are installing directly from the downloaded install files, then please follow the instructions
provided on that Web site. Otherwise, insert the Workpaper Manager installation media
created. If autorun is enabled, the CCH ProSystem fx Workpaper Manager Installation screen
displays. If autorun is not enabled, select Start > Run . In the Open field, enter the path to the
file X:\launchscreen.exe and click OK.
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The following options are available from the launch screen:

SQL Express 2012 SP2 . Installs the Workpaper Manager SQL database instance
using SQL Express 2012. This option should be selected only if an Workpaper Manager
SQL database instance does not already exist and you want to install the 2012 release of
SQL Express.
SQL Express 2014 SP1 . Installs the Workpaper Manager SQL database instance
using SQL Express 2014. This option should be selected only if an Workpaper Manager
SQL database instance does not already exist and you want to install the 2014 release of
SQL Express.
SQL Express 2016 . Installs the Workpaper Manager SQL database instance using
SQL Express 2016. This option should be selected only if an Workpaper Manager SQL
database instance does not already exist and you want to install the 2016 release of SQL
Express. To upgrade from a 32-bit version of a SQL instance refer to Knowledge Base
article.
EngagementWorkpaper Manager . Installs Workpaper Manager.
Installation Guide . Opens the CCH ProSystem fx Workpaper Manager Installation
Guide PDF.
Technical Support Web Site . Launches the CCH ProSystem fx Workpaper Manager
Support Web site.
Browse Install Media . Displays the contents of the install media in Windows® Explorer.
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Notes:
When launching the installation from the contents of the install media, it is
imperative that CSWMSetup.exe is selected with Windows® 7, Windows® 8.1,
and Server 2012 or higher. CSWMSetup.exe provides elevated privileges for
installations on these operating systems.
You need Adobe® Reader® to view the Installation Guide or Release Notes,
and the CCH ProSystem fx Workpaper Manager User Guide. Adobe® Reader®
11 and DC is included on the Workpaper Manager Installation Media.
The Install CCH ProSystem fx Workpaper Manager launch screen uses an .ini
file to customize which buttons are displayed. To remove a button from the
launch screen, edit the "product.ini" file, which is located at the root of the
installation disc. Remove any section from the product.ini file to remove the
corresponding button from the launch screen.

3. Click Install Workpaper Manager . The Welcome screen displays.
4. Click Next. The License Agreement dialog displays.
5. Read the license agreement. If you agree to the terms, select I accept the terms in the
license agreement and click Next.
6. Click Next. The Custom Setup page displays.

7. Select the module or modules to install. Click the appropriate icon and select This feature will
be installed on local hard drive to install the module or This feature, and all subfeatures,
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will be installed on local hard drive to install the module and all subfeatures (for example,
Workpaper Manager CD Image for Administrator, or Templates and Sample Binder for
Workpaper Management).
Workpaper Management. Workpaper Management should be installed on computers
that will be accessed by Workpaper Manager staff members.
Note : If you would like to change the installation path, click the Browse button and
navigate to the desired location.
Administrator . The Administrator module should be installed on a dedicated computer
that is designated as the main office server. Computers with the Workpaper
Management module installed need access to this main office server computer.
Notes:
If you plan to create a secondary office server or servers, install the
CCH ProSystem fx Workpaper Manager Administrator module on a separate
dedicated computer. When more than one office server exists, workstations with
Workpaper Management installed do not necessarily need a network connection
to both office servers. Some can connect to the main office server while others
connect to a secondary office server.
It is not mandatory to have a network connection between the main and
secondary office servers. Data can be passed between the two using Create
and Receive Admin Packages. For more information, see the topics Creating
an Admin Package and Receiving an Admin Package in Chapter 3 of the User
Guide.

Administrator Workstation . The Administrator Workstation setup allows you to access
the Administrator module remotely.
8. If you selected Administrator in step 11 (with or without Workpaper Management) the
Administrator Bin Database Path dialog displays. The system creates the database in the
default folder on your local computer unless you click Browse and specify a different location.
9. Click Next. The Ready to Install dialog displays.
Notes:
If you attempt to install conflicting applications, such as Administrator and Administrator
Workstation, InstallShield displays a conflict message specifying the conflicting
applications. Click Back to make the necessary changes.
If your system does not meet the requirements for the application you are installing,
InstallShield displays a message listing the missing components. Click Cancel to install
the necessary components. Click Back to install a different application. For detailed
information about the new bin structure of the Workpaper Manager database, see
Managing Bins, Workpaper Manager Administrator, in the Workpaper ManagerUser
Guide.
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10. Click Install. InstallShield displays the progress screen as the necessary programs and features
are installed.
11. If you are installing Administrator, read the information on the Backup Information dialog and
select I have read the above warning , then click Next. The InstallShield Wizard Completed
dialog displays.
12. Click Finish , then complete any applicable tasks in the Post-Installation Checklist on the
facing page.

Upgrading an Existing Version of Workpaper Manager
To upgrade a previous Workpaper Manager version, do the following:

Note : Upgrades are only supported for the two previous versions of Workpaper Manager.
1. Complete all tasks in the Pre-Installation Checklist on page 14.
2. If you are installing directly from the downloaded install files, then please follow the instructions
provided on that Web site. Otherwise, insert the Workpaper Manager installation media
created.
3. If Autorun is enabled, the Welcome to the InstallShield Wizard for CCH ProSystem fx
Workpaper Manager screen displays.
If Autorun is not enabled, the Run dialog displays. In the Open field, enter the path to the file
X:\ProSystem fx Engagement.exe and click OK. The screen displays.

Notes:
When upgrading, you do not need to install SQL Server® because Workpaper Manager is
already installed and the.Workpaper Manager SQL Database instance should already
exist.
The Welcome to the InstallShield Wizard for CCH ProSystem fx Workpaper Manager
launch screen uses an .ini file to customize which buttons are displayed. To remove a
button from the launch screen, edit the "product.ini" file, which is located at the root of
the installation disc. Remove any section from the product.ini file to remove the
corresponding button from the launch screen.

4. Click Install Workpaper Manager to upgrade the currently installed features for the
Workpaper Manager installation. The Welcome screen displays.
5. Click Next. The License Agreement dialog displays.
6. Read the license agreement. If you agree to the terms, select I accept the terms in the
license agreement and click Next.
7. Click Next. The Upgrade to CCH ProSystem fx Workpaper Manager 2017 page displays.
8. If you have read the warning message and have created a backup then select that option and
click Next. The Ready to Install dialog displays.
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Note : If your system does not meet the requirements for the application you are installing,
InstallShield displays a message listing the missing components. Click Cancel to install the
necessary components. Click Back to install a different application. For detailed
information about the new bin structure of the Workpaper Manager database, see Chapter
3 of the User Guide.
9. Click Install. InstallShield displays the Progress screen as the necessary programs and
features are upgraded.
10. If Administrator is being upgraded, read the information on the Backup Information dialog,
select I have read the above warning , and then click Next. The InstallShield Wizard
Completed dialog displays.
11. Click Finish , then complete any applicable tasks in the Post-Installation Checklist below.

Post-Installation Checklist
After completing the installation, you should perform the following tasks, as applicable:
If you have upgraded to CCH ProSystem fx Workpaper Manager 2017 from a prior version,
perform a full back up of all central admin and bin databases after installation.
Verify that all administrative users have full access to the Admin Share folder on the office
server. This folder, which is created during the installation, is shared by default, but the network
administrator needs to ensure that all Workpaper Manager administrative users have full rights
to that location.
The installation process sets the Workpaper Manager folder permissions automatically. These
rights are needed for Workpaper Manager to function optimally. The installation gives the
“Users” group all rights except Full Control. These rights are inherited by all child objects so that
all folders and subfolders within Workpaper Manager receive these same rights.
If you have never launched Microsoft ® Office Excel®, Word or Outlook® on a machine with a
new install of Workpaper Manager, then you must launch one of these Microsoft ® Office
products prior to launching Workpaper Manager. This allows Workpaper Manager to
successfully install the add ins needed for working with Microsoft ® Office.

Altering a Current Install of Workpaper Manager
CCH ProSystem fx Workpaper Manager Program Maintenance allows you to modify, repair, or
remove the current installation.

Modifying a Current Install
To add new program features or remove currently installed features, do the following:

1. Close all programs on your computer.
2. Select Programs and Features (or Add or Remove Programs) from your computer's
Control Panel.
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Note : Some modifications will require elevated privileges. For best results, use the
executable on the Installation Media or CCH ProSystem fx Workpaper Manager image.
3. Select CCH ProSystem fx Workpaper Manager from the list and click Change to open the
Welcome dialog.
4. Click Next to display the Program Maintenance dialog.

5. Select Modify and then click Next. The Custom Setup dialog displays.
6. Select applications to install and deselect applications to remove. Click the plus sign (+), where
available, to select individual options to install or remove. The Custom Setup dialog displays
the amount of space required for installation.
7. Click Next to display the Ready to Modify dialog.
8. Click Install to begin the update process. The InstallShield Wizard Completed dialog displays
when the process is finished.
9. Click Finish to exit the installation.

Repairing a Current Install
To repair program features from a previous installation, do the following:

1. Close all programs on your computer.
2. Select Add or Remove Programs or Programs and Features from your computer's Control
Panel.
Note : Some repairs will require elevated privileges. For best results, use the executable on
the Installation Media or CCH ProSystem fx Workpaper Manager image.
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3. Select CCH ProSystem fx Workpaper Manager from the list and click Change to open the
Welcome dialog.
4. Click Next. The Program Maintenance dialog displays.
5. Select Repair and then click Next. The Ready to Repair dialog displays.
6. Click Install. The Installing CCH ProSystem fx Workpaper Manager status bar displays while
InstallShield repairs the installation(s). Once the repair process is finished, the InstallShield
Wizard Completed dialog displays.
7. Click Finish .

Removing CCH ProSystem fx Workpaper Manager
To remove all installed features, do the following:

1. Close all programs on your computer.
2. Select Add or Remove Programs or Programs and Features from your computer's Control
Panel.
3. Select CCH ProSystem fx Workpaper Manager from the list and click Remove to display
the Welcome dialog.
4. Click Yes on the confirmation dialog. Windows® removes all CCH ProSystem fx
Workpaper Manager applications.

Terminal Services Installation
The installation of Workpaper Manager can vary based on the Terminal Services and Citrix® software
setup. For this reason, we strongly suggest that you consult with your network administrator prior to
installing Workpaper Manager.
For detailed information on setting up Terminal Services, see the CCH ProSystem fx
Workpaper Manager Deployment Planning Guide in the Documents folder of the Installation Media.
We also advise contacting Technical Support prior to installation to address any questions you may
encounter with the installation.

Important:
The Terminal Services Database and Terminal Services Client should not be installed on the
same computer.
The following instructions outline the preferred steps for installing CCH ProSystem fx
Workpaper Manager Terminal Services Client; however, your configuration may require
additional or alternate steps. For additional assistance, please contact Technical Support.
Installing Terminal Services on a domain controller, Microsoft ® Small Business Server®,
Windows Server® Essentials, Windows Server® Foundation, or Exchange Server® are not
supported.
Before beginning, install CCH ProSystem fx Workpaper Manager Administrator. Refer to the
Installation Instructions on page 15 for instructions.
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The following section contains instructions for installing the CCH ProSystem fx Workpaper Manager
Terminal Services Client
(Workpaper Management for Terminal Services), CCH ProSystem fx Workpaper Manager Terminal
Services Database, and CCH ProSystem fx Workpaper Manager Administrator Workstation.

Terminal Services Database Installation
This section provides installation instructions for CCH ProSystem fx Workpaper Manager Terminal
Services Database on a Windows® Terminal Services enabled server.
Keep the following in mind when installing Terminal Services Database:
This location should be a dedicated Windows® server with enough space to store data being
created in the Terminal Services Client module.
The recommended location is the main office server where the CCH ProSystem fx
Workpaper Manager Administrator is installed. The Terminal Services Database installation
must be performed at the server console of the computer it is to reside on.
For robust environments (for example, more than 75 users), SQL Standard Edition or
SQL Enterprise Edition are recommended. For more information on choosing a SQL server®,
see the CCH ProSystem fx Workpaper Manager Deployment Planning Guide, located in the
Documents folder of your Installation Media.
To install Terminal Services Database, do the following:

1. Complete all tasks in the Pre-Installation Checklist on page 14.
2. Insert the CCH ProSystem fx Workpaper Manager Installation Media. If you are installing
directly from the downloaded install files, then please follow the instructions provided on that
Web site.
3. Open Control Panel and select Install Application on Remote Desktop Server when on
Server 2012 or Server 2016.
4. Browse to the Installation Media and then click Next. The Install Program from Floppy Disk or
CD-ROM dialog displays.
5. Click Next. The Run Installation Program dialog displays.
6. If a Workpaper Manager SQL Instance is already installed, skip to step 15.
If a Workpaper Manager SQL Instance is not already installed, do one of the following:
Install Microsoft ® SQL Server® Standard or Enterprise edition as explained in see
Appendix A: Installing SQL Server® 2012 on page 28 , Appendix B: Installing SQL
Server® 2014 on page 42, or Appendix C: Installing SQL Server® 2016 on page 54.
Install Microsoft ® SQL Express® 2012, Microsoft ® SQL Express® 2014,or Microsoft ®
SQL Express® 2016 which are included on the Workpaper Manager installation media.
To install SQL Express® 2012 , 2014, or 2016 continue to step 8.
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7. Click Browse and locate either the ProSystem fx SQL 2012 Instance Installer.exe ,
ProSystem fx SQL 2014 Instance Installer.exe , or ProSystem fx SQL 2016 Instance
Installer.exe .
Note : Choose only one of the installers to install: ProSystem fx SQL 2012 , ProSystem fx
SQL 2014 or ProSystem fx SQL 2016.
8. Click Finish . The SQL 2012, SQL 2014, or SQL 2016 Instance Installer wizard displays.
9. Click Next. The Ready to Install the Program page displays.
10. Click Install. Several status screens display as the SQL Instance is installed.
11. Click Finish .
12. Click CD or Floppy, and then click Next. The Install Program from Floppy Disk or CD-ROM
dialog displays.
13. Click Next. The Run Installation Program dialog displays.
14. Click Browse and locate the PfxEngSetup.exe file.
15. Click Finish . The Welcome dialog displays.
Note : You need Adobe® Reader® to view the Installation Guide or Release Notes, and
the CCH ProSystem fx Workpaper Manager User Guide. Adobe® Reader® 11 and DC is
included on the Workpaper Manager Installation Media.
16. Click Next. The License Agreement dialog displays.
17. Read the license agreement. If you agree to the terms, select I accept the terms in the
license agreement and click Next.
18. Click Next. The Custom Setup dialog displays.
19. Select Terminal Services Database . Click the plus sign (+) to select or deselect subfeatures
to install, or choose This feature, and all subfeatures, will be installed on local hard drive.
Deselect Workpaper Management, which is selected by default.
20. Click Next. The Ready to Install screen displays.
Notes:
If you attempt to install conflicting applications, InstallShield displays a message
specifying the conflicting applications. Click Back to make the necessary changes.
If your system does not meet the requirements for the application you are installing,
InstallShield displays the Requirements dialog, listing the necessary components. Click
Cancel to install the necessary components, or click Back to change the application to
install.

21. Click Install. The Installing CCH ProSystem fx Workpaper Manager status bar displays as
InstallShield completes the installation. The InstallShield Wizard Completed dialog displays.
22. Click Finish , then complete any applicable tasks in the Post-Installation Checklist on page 20.
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Terminal Services Client Installation
This section provides installation instructions for CCH ProSystem fx Workpaper Manager Terminal
Services Client on a Windows® Terminal Services enabled server.

1. Complete all tasks in the Pre-Installation Checklist on page 14.
2. Determine that no one is accessing the Terminal Services server.
3. Insert the CCH ProSystem fx Workpaper Manager Installation Media. If you are installing
directly from the downloaded install files, then please follow the instructions provided on that
Web site.
4. Open Control Panel and select Install Application on Remote Desktop Server when on
Server 2012 or Server 2016.
5. Browse to the Installation Media, and then click Next. The Install Program from Floppy Disk
or CD-ROM dialog displays.
6. Click Next. The Run Installation Program dialog displays.
7. Click Browse and locate the PfxEngSetup.exe file.
8. Click Next. The Welcome dialog displays.
Note : You need Adobe® Reader® to view the Installation Guide or Release Notes, and
the CCH ProSystem fx Workpaper Manager User Guide. Adobe® Reader® 11 and DC is
included on the Workpaper Manager Installation Media.
9. Click Next. The License Agreement dialog displays.
10. Read the license agreement. If you agree to the terms, select I accept the terms in the
license agreement and click Next.
11. Click Next. The Custom Setup dialog displays.
12. Select the program feature to install: Terminal Services Client only or Terminal Services Client
with Administrator Workstation. Click the plus sign (+) to select or deselect subfeatures to
install, or choose This feature, and all subfeatures, will be installed on local hard drive.
Deselect Workpaper Management, which is selected by default.
13. Click Next to display the Terminal Services Database Location dialog. Enter the name of the
server where the database is installed.
14. Click Next. The Ready to Install screen displays.
Notes:
If you attempt to install conflicting applications, InstallShield displays a message
specifying the conflicting applications. Click Back to make the necessary changes.
If your system does not meet the requirements for the application you are installing,
InstallShield displays the Requirements dialog, listing the necessary components. Click
Cancel to install the necessary components, or click Back to change the application to
install.
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15. Click Install. The Installing CCH ProSystem fx Workpaper Manager status bar displays as
InstallShield completes the installation. The InstallShield Wizard Completed dialog displays.
16. Click Finish , then complete any applicable tasks in the Post-Installation Checklist on page 20.

Using the CCH ProSystem fx Workpaper Manager Administrator
From the Windows® Start menu, select the program group where you installed the CCH ProSystem fx
Workpaper Manager Administrator. Select CCH ProSystem fx Workpaper Manager
Administrator , or double-click the Administrator icon on your desktop. The CCH ProSystem fx
Workpaper Manager Admin Login dialog displays.

Initial Login to the Workpaper Manager Administrator
Only staff assigned to the Administrator Staff Group can log in to the Administrator. The program
provides one default staff member in the Administrator Staff Group. You can modify the password
and staff information for the default user, but you cannot change the Login Name or delete this staff
member. There is no limit to the number of licensed staff you can assign as administrators.

Note : If you want other workstations to access the Administrator module, install Administrator
Workstation to those workstations. See Installation Instructions on page 15.
The first time you log in, do the following:

1. Start Workpaper Manager Administrator by doing one of the following:
Double-click the Workpaper Manager Admin icon on your desktop.
Select Start > Programs > CCH ProSystem fx Workpaper Manager >
CCH ProSystem fx Workpaper Manager Admin .
The Workpaper Manager Admin Login displays.

2. In the Login Name field, enter ADMIN. Leave the Password field blank.
3. Click OK. The CCH ProSystem fx Workpaper Manager Administrator program detects that a
main office server has not been set up and displays a message that the computer must be
configured as an office server before you can log in.
4. Click Yes. The Provide Office Server Information dialog displays.
5. Enter a label of up to 32 characters for the main office server in the Label field. The label is
required and is used as the office server's name.
6. The Server name field defaults to the name of the computer to which you are logged in.
7. Enter a description for the server of up to 60 characters in the Description field. The description
is optional.
8. Click Next. The Determine the office server designation dialog displays.
9. Select Main office server to establish this as the main office server.
10. If the Firm has more than one office server and this office server does not have a physical
connection with the other office server(s), check the Disable Admin Synchronization check
box.
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11. Click OK. The Firm Properties dialog displays.
12. Enter the firm information and click Next. The Configure Office Server Summary Report
displays.
13. Do any of the following:
Click Print to print the summary report.
Click Save As to save the report as an HTML file.
Click Back to make changes to your settings.
Click Cancel to discard your work and exit the Configure Office Server Wizard.
Click Finish to save your settings and open Workpaper Manager Administrator.
Once you are in the program, you can change the administrator's password and add more staff to the
Admin group, if needed. See Adding New Staff Members in Chapter 3 of the User Guide.

Important: The CCH ProSystem fx Workpaper Manager Backup and Restore Utility should be
used on a nightly basis. See Appendix F: Database Backup and Restore on page 77.
Note : For instructions on creating a secondary server, refer to the section Setting up the
Administrator Environment in Chapter 3 of the User Guide.
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Appendix A

INSTALLING SQL SERVER® 2012
Appendi x A: Instal l i ng SQL Server ® 2012

Installing SQL Server® 2012
Creating a New SQL 2012 32-bit or 64-bit Instance for Workpaper Manager
This section provides step-by-step instructions for creating a new SQL 2012 32-bit or 64-bit instance
for CCH ProSystem fx Workpaper Manager.
If you need to create a new instance for SQL 2012 Express 64-bit, please see Creating a New SQL
2012 Express 64-bit Instance for Workpaper Manager on page 40.

Important: Configure the SQL Service® to use "LocalSystem" (or NT AUTHORITY\SYSTEM) as
the start-up account and the SQL Browser to use "Local Service" as the start-up account.

Upgrading SQL 2012
SQL Server® 2012 supports an upgrade from the following versions of SQL Server®:
SQL Server® 2005 SP4 (9.00.5000.00) or later
SQL Server® 2008 SP2 (10.00.4000.00) or later
SQL Server® 2008 R2 SP1 (10.50.2500.0) or later

Note : To find what version of SQL is currently installed, browse the Registry and go to the key:
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Microsoft SQLServer\PROFX
ENGAGEMENT\MSSQLServer\CurrentVersion.
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Recommended Operating Systems
We recommend using Microsoft ® Windows Server® 2012 (64-bit) with SQL Server® 2012.

Creating the SQL Server® 2012 Instance
Note : Please follow each step carefully to ensure that the SQL instance is properly created with
all required settings.
1. Insert the SQL Server® 2012 Installation Media.
2. Click Installation .
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3. Select New SQL Server stand-alone installation or add features to an existing
installation . The Setup Support Rules screen displays.

4. Click OK to proceed with the installation. The Product Key screen displays.
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5. Enter the SQL Server® product key and click Next. The License Terms screen displays.

6. Click I accept the license terms and click Next. The Install Setup Files screen displays.
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7. Click Next on the Setup Support Rules screen.

8. Select SQL Server Feature Installation on the Setup Role screen.
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9. Select Database Engine Services and Management Tools on the Feature Selection
screen.

10. Click Next to continue.
Note : Management Tools are optional for Workpaper Manager. However, they can be used
to assist support in certain circumstances.
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11. Click Next on the Installation Rules page.

12. Select Named Instance and enter “PROFXENGAGEMENT” on the Instance Configuration
screen.
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13. Click Next to continue. The Disk Space Requirements screen displays.

14. Click Next to continue.
15. On the Service Accounts tab of the Server Configuration screen, verify the SQL Server
Database Engine Startup Type is set to Automatic.
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16. Leave the default settings on the Collation tab. If the default settings for your installation do not
match those shown in the screen below, update your settings.

17. Click Next to continue.
18. Select Windows authentication mode on the Database Engine Configuration screen.
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19. Add an Administrator user account in the Specify SQL Server administrators field.

20. Click Next to continue.The Error and Usage Reporting screen displays.
21. Click Next to continue. The Installation Configuration Rules screen displays.

22. Click Show Details to see a detailed report of the Installation Rules.
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23. Click Next to continue. The Ready to Install screen displays.

24. Verify the SQL Server 2012 features to install, and then click Install to continue. The
Installation Progress screen displays.
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25. Click Next to continue.
Note : Please be patient; the install process can take a long time to complete. The
Installation Progress screen will provide a notification when the setup process has
completed.
26. Click Next to continue. The Complete screen displays.

27. Click Close to finish the installation.
28. After installation completes, you will need to go into the SQL Server® Configuration Manager
and enable TCP/IP for the instance and restart the service.
Note : If SQL Server® is manually installed, it will be necessary to modify the SQL Server®
service account to either the Local System account, or another administrative service
account that has adequate permissions to create database files in the Workpaper Manager
installation location. All Workpaper Manager database files are created in sub-folders of the
installation location.
Example : If Workpaper Manager is installed to the X:\Pfx Engagement folder, then the
SQL Server® service account needs to be modified to an administrative service account that
has permissions to read/write files to the X:\Pfx Engagement folder. This step must be done
after installing SQL Server®, but before starting the installation of CCH ProSystem fx
Workpaper Manager on the server.
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Install SQL 2012 Express Instance Installer or Upgrade from SQL
2008 or SQL 2005 32-bit Express Instance Installer
1. Launch SQL2012ExpressInstanceInstaller.exe. SQLEXPR_x86_ENU.exe must be in the same
folder.
2. Click Install or Upgrade SQL PROFXENGAGEMENT instance after all requirements are
met
3. Click Run .
Note : Please be patient; the install process can take a long time to complete.

Creating a New SQL 2012 Express 64-bit Instance for Workpaper
Manager
Though SQL 2012 Express 64-bit is supported, there currently is no installer available to create the
CCH ProSystem fx Workpaper Manager SQL instance. This section provides step-by-step
instructions for creating a new SQL 2012 Express 64-bit instance for CCH ProSystem fx
Workpaper Manager.

Note : Please make sure that you follow each step carefully to ensure that the SQL instance is
properly created with all required settings.
1. Download the install package from the Microsoft ® Web site and launch it.
2. Click New Installation or add features to an existing installation.
3. Select I accept the license terms and click Next. The Setup Support Files screen displays.
4. Select Install to proceed with the installation . The Feature Selection screen displays.
5. Click Unselect All.
6. Choose Database Engine Services under Instance Features and Management Tools –
Basic under Shared Features.
7. Click Next.
Note : Management Tools are optional for Workpaper Manager. However, they can be used
to assist support in certain circumstances.
8. Select Named Instance and enter “PROFXENGAGEMENT” on the Instance Configuration
screen.
9. Click Next to continue.
10. On the Service Accounts tab of the Server Configuration screen, select Use the same
account for all SQL Server ® services on the Authentication Mode screen.
11. Change the Account Name to NT AUTHORITY\SYSTEM for the SQL Server® Database
Engine. Verify the Startup Type is set to “Automatic” for SQL Server® Database Engine and for
SQL Server® Browser.
12. Click Next to continue.
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13. Select Windows® authentication mode on the Database Engine Configuration screen.
14. Add an Administrator user account in the Specify SQL Server ® administrators field.
15. Click Next to continue. The Error Reporting screen displays.
16. Click Next to continue. The Installation Progress screen displays. Please be patient; the install
process can take a long time to complete.
17. Click Next to continue. The Complete screen displays.
18. Click Close to finish the installation.
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Appendix B

INSTALLING SQL SERVER® 2014
Appendi x B: Instal l i ng SQL Server ® 2014

Installing SQL Server® 2014
Creating a New SQL Server® 2014 32-bit or 64-bit Instance for Workpaper
Manager
This section provides step-by-step instructions for creating a new SQL Server® 2014 32-bit or 64-bit
instance for CCH ProSystem fx Workpaper Manager.
If you need to create a new instance for SQL Server® 2014 Express 64-bit, please see Creating a SQL
Server® 2014 Express 64-bit Instance for Workpaper Manager on page 52.

Important: Configure the SQL Service® to use “LocalSystem” (or NT AUTHORITY\SYSTEM) as
the start-up account and the SQL Browser to use “Local Service” as the start-up account.

Upgrading SQL 2014
SQL Server® 2014 supports an upgrade from the following versions of SQL Server®:
SQL Server® 2005 SP4 or later
SQL Server® 2008 SP3 or later
SQL Server® 2008 R2 SP2 or later
SQL Server® 2012 SP1 or later

Note : To find what version of SQL is currently installed, browse the Registry and go to the key:
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft
SQLServer\PROFXENGAGEMENT\MSSQLServer\CurrentVersion.

Recommended Operating Systems
We recommend using Microsoft ® Windows Server® 2012 (64-bit) or 2012 R2 (64-bit) with SQL
Server® 2014.
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Creating a SQL Server® 2014 Instance
Note : Please make sure that you follow each step carefully to ensure that the SQL instance is
properly created with all required settings.
1. Insert the SQL Server® installation media. From the root folder, double-click Setup.exe . To
install from a network share, locate the root folder on the share, and then double-click
Setup.exe .
2. On the SQL Server Installation Center page, click Installation in the left-hand navigation area,
and then click New SQL Server stand-alone installation or add features to an existing
installation .
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3. On the Product Key page, select an option to indicate whether you are installing a free edition
of SQL Server®, or a production version of the product that has a PID key. For more information
on Editions and Components of SQL Server 2014, see https://msdn.microsoft.com/enus/library/ms144275(v=sql.120).aspx.

4. To continue, click Next.
5. On the License Terms page, review the license agreement and, if you agree, select the I
accept the license terms check box.
Note : To help improve SQL Server®, you can also enable the feature usage option and
send reports to Microsoft ®.
6. Click Next. In the Global Rules window, the setup procedure will automatically advance to the
Product Updates window if there are no rule errors.
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7. The Microsoft Update page will appear next if the Microsoft Update check box in Control Panel
> All Control Panel Items > Windows Update > Change settings is not checked. Check the box to
Use Microsoft Update to check for updates (recommended) and then click Next.

On the Product Updates page, the latest available SQL Server® product updates are
displayed. If no product updates are discovered, SQL Server® Setup does not display
this page and advances to the Install Setup Files page.
On the Install Setup Files page, Setup provides the progress of downloading,
extracting, and installing the Setup files. If an update for SQL Server® Setup is found,
and is specified to be included, that update will also be installed.

8. The Install Rules page identifies potential problems that might occur while running Setup.
Failures must be corrected before Setup can continue.
9. Click Next to continue.
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10. On the Setup Role page, select SQL Server Feature Installation .

11. Click Next to continue to the Feature Selection page.
12. On the Feature Selection page, select Database Engine Services and Management
Tools. A description for each component group appears in the Feature description pane after
you select the feature name. You can select any combination of check boxes. For more
information, see
Editions and Components of SQL Server 2014, https://msdn.microsoft.com/enus/library/ms144275(v=sql.120).aspx.
Features Supported by the Editions of SQL Server 2014,

https://msdn.microsoft.com/en-us/library/cc645993(v=sql.120).aspx.
Click Next to continue.

Note : Management Tools are optional for Workpaper Manager. However, they can be used
to assist support in certain circumstances.
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13. The Feature Rules window will automatically advance if all rules pass.
14. On the Instance Configuration page, select Named Instance and enter
PROFXENGAGEMENT. By default, the instance name is used as the Instance ID.
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15. On the Service Accounts tab of the Server Configuration page, verify the SQL Server
Database Engine and SQL Server Browser Startup Type is set to Automatic. Use the
Service Accounts tab to specify login accounts for SQL Server® services. The actual services
that are configured on this page depend on the features that you selected to install.
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16. On the Collation tab of the Server Configuration page, leave the default settings. If the default
settings for your installation do not match those shown in the screen below, update your
settings.
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17. Click Next to continue.
18. On the Database Engine Configuration page, select Windows authentication mode and add
at least one system administrator to the Specify SQL Server administrators box.

19. Click Next to continue.
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20. The Ready to Install page shows a tree view of installation options that were specified during
Setup. Verify the features to be installed, and then click Install to continue.

The Installation Progress page provides status so that you can monitor installation progress as
Setup continues.

Note : Please be patient; the install process can take a long time to complete. The
Installation Progress screen will provide a notification when the setup process has
completed.

21. After installation, the Complete page provides a link to the summary log file for the installation
and other important notes. To complete the SQL Server® installation process, click Close .
22. After installation completes, you will need to go into the SQL Server® Configuration Manager
and enable TCP/IP for the instance and restart the service.
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Note : If SQL Server® is manually installed, it will be necessary to modify the SQL Server®
service account to either the Local System account, or another administrative service
account that has adequate permissions to create database files in the Workpaper Manager
installation location. All Workpaper Manager database files are created in sub-folders of the
installation location.
Example : If Workpaper Manager is installed to the X:\Pfx Engagement folder, then the
SQL Server® service account needs to be modified to an administrative service account that
has permissions to read/write files to the X:\Pfx Engagement folder. This step must be done
after installing SQL Server®, but before starting the installation of CCH ProSystem fx
Workpaper Manager on the server.

Creating a SQL Server® 2014 Express Instance or Upgrading a
32-bit Instance for Workpaper Manager
1. Launch SQL2014ExpressInstanceInstaller.exe. Verify SQLEXPR_86_ENU.exe is in the same
folder.
2. Click Install or Upgrade SQL PROFXENGAGEMENT instance after all requirements are
met.
3. Click Run .
Note : Please be patient; the install process can take a long time to complete.

Creating a SQL Server® 2014 Express 64-bit Instance for
Workpaper Manager
Though SQL Server® 2014 Express 64-bit is supported, there currently is no installer available to
create the CCH ProSystem fx Workpaper Manager SQL instance. This section provides step-by-step
instructions for creating a new SQL Server® 2014 Express 64-bit instance for CCH ProSystem fx
Workpaper Manager.

Note : Please make sure that you follow each step carefully to ensure that the SQL instance is
properly created with all required settings.
1. Download the install package from the Microsoft ® Web site and launch it.
2. Click Installation and select New SQL Server ® stand-alone installation or add features
to an existing installation . The License Terms screen appears
3. Click I accept the license terms and click Next. The Product Updates screen appears.
4. On the Product Updates page, the latest available SQL Server® product updates are displayed.
If you don't want to include the updates, clear the Include SQL Server ® product updates
check box. If no product updates are discovered, SQL Server® Setup does not display this page
and auto advances to the Feature Selection page.
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5. Click Next. The Feature Selection window appears.
6. Click Unselect All.
7. Select Database Engine Services under Instance Features.
8. Click Next. The Instance Configuration screen appears.
Note : Management Tools are optional for Workpaper Manager. However, they can be used
to assist support in certain circumstances.
9. Select Named instance and enter PROFXENGAGEMENT.
10. Click Next. The Server Configuration screen appears. Microsoft ® recommends that you use a
separate account for each SQL Server® service. Verify the Startup Type is set to “Automatic”
for both SQL Server ® Database Engine and SQL Server ® Browser .
11. Click Next. The Database Engine Configuration screen appears.
12. Select Windows® authentication mode .
13. Add an Administer user account in the Specify SQL Server® administrators field.
14. Click Next. The Installation Progress screen appears. Please be patient; the install process can
take a long time to complete.
15. Click Next. The Complete screen displays.
16. Click Close to finish the installation.
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Appendix C

INSTALLING SQL SERVER® 2016
Appendi x C: Instal l i ng SQL Server ® 2016

Installing SQL Server® 2016
Creating a New SQL Server® 2016 64-bit Instance for Workpaper Manager
This section provides step-by-step instructions for creating a new SQL Server® 2016 64-bit instance
for CCH ProSystem fx Workpaper Manager.
If you need to create a new instance for SQL Server® 2016 Express 64-bit, please see Creating a SQL

Server® 2016 Express Instance or Upgrading a 64-bit Instance for Workpaper Manager on
page 65.
Important: Configure the SQL Service® to use “LocalSystem” (or NT AUTHORITY\SYSTEM) as
the start-up account and the SQL Browser to use “Local Service” as the start-up account.

Upgrading SQL 2016
SQL Server® 2016 supports an upgrade from the following 64-bit versions of SQL Server®:
SQL Server® 2008 SP4 or later
SQL Server® 2008 R2 SP2 or later
SQL Server® 2012 SP1 or later
SQL Server® 2014 or later

Notes:
To find what version of SQL is currently installed, browse the Registry and go to the key:
HKEY _ LOCAL_MACHINE\SOFTWARE\Microsoft
SQLServer\PROFXENGAGEMENT\MSSQLServer\CurrentVersion.
For more information about upgrading to SQL Server® 2016, see Upgrading from a 32-bit
Microsoft® SQL Server® Instance to SQL Server® 2016 on page 65.
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Recommended Operating Systems
We recommend using Microsoft ® Windows Server® 2012 (64-bit), 2012 R2 (64-bit) or 2016 (64-bit)
with SQL Server® 2016.

Creating a SQL Server® 2016 Instance
Note : Please make sure that you follow each step carefully to ensure that the SQL instance is
properly created with all required settings.
1. Insert the SQL Server® installation media. From the root folder, double-click Setup.exe . To
install from a network share, locate the root folder on the share, and then double-click
Setup.exe .
2. On the SQL Server Installation Center page, click Installation in the left-hand navigation area,
and then click New SQL Server stand-alone installation or add features to an existing
installation .
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3. On the Product Key page, select an option to indicate whether you are installing a free edition
of SQL Server® or a production version that has a PID key. For more information, see Editions
and Components of SQL Server.

4. To continue, click Next.
5. On the License Terms page, review the license agreement and, if you agree, select the I
accept the license terms check box.
6. Click Next. In the Global Rules window, the setup procedure will automatically advance to the
Product Updates window if there are no rule errors.
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7. If the Microsoft Update option is not selected in Control Panel > All Control Panel Items >
Windows Update > Change settings, then the Microsoft Update page displays. Select the Use
Microsoft Update to check for updates (recommended) option, and then, click Next. If the
Microsoft Update option is selected, continue to the next step,

On the Product Updates page, the latest available SQL Server® product updates are
displayed. If no product updates are discovered, SQL Server® Setup does not display
this page and advances to the Install Setup Files page.
On the Install Setup Files page, Setup provides the progress of downloading,
extracting, and installing the Setup files. If an update for SQL Server® Setup is found,
and is specified to be included, that update will also be installed.

8. The Install Rules page identifies potential problems that might occur while running Setup.
Failures must be corrected before Setup can continue.
9. Click Next to continue
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10. On the Feature Selection page, select Database Engine Services. A description for each
component group appears in the Feature description pane after you select the feature name.
You can select any combination of check boxes. For more information, see Editions and
Components of SQL Server.

11. Click Next to continue. The Feature Rules window will automatically advance if all rules pass.
12. On the Instance Configuration page, select Named Instance and enter
PROFXENGAGEMENT. By default, the instance name is used as the Instance ID.

Appendix C: Installing SQL Server® 2016 • 58

13. On the Service Accounts tab of the Server Configuration page, verify the SQL Server
Database Engine and SQL Server Browser Startup Type is set to Automatic. Use the
Service Accounts tab to specify login accounts for SQL Server® services. The actual services
that are configured on this page depend on the features that you selected to install.

Important: Do not select the box Grant Perform Volume Maintenance Task privilege
to SQL Server Database Engine Service .
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14. On the Collation tab of the Server Configuration page, leave the default settings. If the default
settings for your installation do not match those shown in the screen below, update your
settings.

15. Click Next to continue.
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16. On the Database Engine Configuration page, select Windows authentication mode and add
at least one system administrator to the Specify SQL Server administrators box.

17. Click Next to continue.
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18. The Ready to Install page shows a tree view of installation options that were specified during
setup. Verify the features to be installed, and then click Install to continue.

The Installation Progress page provides status so that you can monitor installation progress as
Setup continues.

Note : Please be patient; the install process can take a long time to complete. The
Installation Progress screen will provide a notification when the setup process has
completed.
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19. After installation, the Complete page provides a link to the summary log file for the installation
and other important notes. To complete the SQL Server® installation process, click Close .
20. After the SQL Server installation completes, we recommend that you install Management
Tools. On the SQL Server® Installation Center page, click Installation in the left-hand
navigation area, and then click Install SQL Server Management Tools. A web browser will
then open.
Note : Management Tools are optional for Workpaper Manager. However, they can be used
to assist support in certain circumstances.

21. Select Download SQL Server Management Studio 17.1 and save the SSMS-SetupENU.exe .
Note : To download the installation, you will need to ensure your security settings allow for
file downloads.
22. Once the download is complete, double-click the file to run the installation. If prompted, select
Run to continue with the installation.
23. On the Microsoft SQL Server Management Studio Welcome page, click Install. The
Installation Progress page provides status so that you can monitor installation progress as
setup continues.
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Notes:
By selecting Install, you are acknowledging and accepting the license terms and privacy
statement.
Please be patient; the install process can take a long time to complete. The Installation
Progress screen will provide a notification when the setup process has completed.

24. Once the installation has completed, click Restart.
25. After restarting, open SQL Server® Configuration Manager and do the following to enable
TCP/IP for the instance:
a. Select the arrow to the left of SQL Server Network Configuration .
b. Select Protocols for PROFXENGAGEMENT. If TCP/IP in the right pane is disabled,
double-click TCP/IP. Select Yes to enable it.
c. Select the IP Addresses tab.
d. Under IPAll, delete the TCP Dynamic Ports and set the TCP Port to 2029 .
e. Click OK. You will then need to restart the service.
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Note : If SQL Server® is manually installed, it will be necessary to modify the SQL Server®
service account to either the Local System account, or another administrative service
account that has adequate permissions to create database files in the Workpaper Manager
installation location. All Workpaper Manager database files are created in sub-folders of the
installation location.
Example : If Workpaper Manager is installed to the X:\Pfx Engagement folder, then the
SQL Server® service account needs to be modified to an administrative service account that
has permissions to read/write files to the X:\Pfx Engagement folder. This step must be done
after installing SQL Server®, but before starting the installation of CCH ProSystem fx
Workpaper Manager on the server.

Upgrading from a 32-bit Microsoft® SQL Server® Instance to SQL
Server® 2016
With most versions of Microsoft ® SQL Server®, there is a 32-bit and a 64-bit version of the program.
Starting with Microsoft ® SQL Server® 2016, you will only be able to install a 64-bit version of the
software. If you already have a 32-bit version of an SQL instance installed, there is not a traditional
upgrade path to convert to a 64-bit platform. To move to a 64-bit platform of Microsoft ® SQL Server®,
you will need to uninstall the 32-bit SQL instance and then re-install the instance using the 64-bit
version. For more information, please refer to this Microsoft® article.

Note : Prior to performing any installation processes with your SQL instance, be sure to use the
proper SQL backup procedures for the installed instance to prevent any data loss. Once the
installation procedure is completed, you can restore your 32-bit backup to the 64-bit version of the
instance without issue.

Creating a SQL Server® 2016 Express Instance or Upgrading a
64-bit Instance for Workpaper Manager
1. Launch CCH ProSystem fx SQL 2016 Instance Installer.exe. Verify SQLEXPR_x64_ENU.exe is
in the same folder.
2. Review the Microsoft ® Software License Terms, and if you agree, select the I accept the
license terms check box.
3. Click Next.
4. Click Install or Upgrade SQL PROFXENGAGEMENT instance after all requirements are
met.
5. Click Run .

Appendix C: Installing SQL Server® 2016 • 65

Notes:
Please be patient; the install process can take a long time to complete.
As mentioned above, you cannot upgrade from a 32-bit SQL instance to SQL® Server 2016 as
this is only available in 64-bit.
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Appendix D

INSTALLING WORKPAPER MANAGER WITH
ACTIVE DIRECTORY®
Appendi x D: Instal l i ng W orkpaper Manager wi th Acti ve Di rectory®

Installing Workpaper Manager with Active Directory®
A Microsoft ® Windows Server®, with Microsoft ® Active Directory®, may be used to push
CCH ProSystem fx Workpaper Manager across multiple computers. CCH ProSystem fx
Workpaper Manager v6.5 and higher are supported when upgrading the program.

Requirements
Before starting, please make sure that all computers to which Workpaper Manager will be deployed
meet the following requirements and have the following components installed:
Machines must meet the minimum requirements for CCH ProSystem fx Workpaper Manager
installation. See Workpaper Manager 2017 System Requirements on page 2.
A SQL Server® 2012, SQL Server® 2014, or SQL Server® 2016 Express instance must be
installed prior to installing CCH ProSystem fx Workpaper Manager.

Note : For machines that have a prior version of Workpaper Manager installed, there is no
need to install a SQL Server® instance again if SQL 2012 or higher is installed, because
those machines already have the Workpaper Manager SQL database instance.
The following applications must be manually installed before a push of the 2017 Workpaper
Management module from Active Directory®:
.Net Framework 4.6.1 Full
SQL Server® 2008 Native Client (32- or 64-bit)
Visual Studio® Tools for Office Runtime 4.0 (VSTOR) (32-bit version for 32-bit OS and
64-bit version for 64-bit OS)
SQLXML 4.0, SP 1
Microsoft ® Visual C++® 2008 Redistributable x86 9.0.30729.17
Microsoft ® Visual C++® 2008 Redistributable x86 9.0.30729.4148
Microsoft ® Visual C++® 2010 Redistributable x86 10.0.40219
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Important:
Deployment of CCH ProSystem fx Workpaper Manager using Active Directory® is supported for
all international versions (United States, Canada, and Australia).
CCH ProSystem fx Workpaper Manager supports SQL Server® 2012 Express, 2014 Express, or
2016 Express. However, due to limitations of the Microsoft ® SQL Express® instance installers, it
is not possible to use Active Directory® to push the installation of the SQL Express® instance.

Pushing CCH ProSystem fx Workpaper Manager
Once all of the above requirements have been met, follow the instructions below to push
CCH ProSystem fx Workpaper Manager across computers in a network using Active Directory®.

1. After verifying that the Server® 2012 Express, SQL Server® 2014 Express, or SQL Server® 2016
Express instance has been installed, open the Group Policy created for the Express installation.
2. In the Group Policy Object Editor under Computer Configuration, expand the Software Settings
folder by clicking on the + icon. Under the Software Settings folder, right-click on Software
installation and select New > Package .
3. Browse to the location of the CCH ProSystem fx Workpaper Manager.msi package that was
copied to the server’s local drive.
Note : When browsing to the location of the installation package, you must use a UNC path.
4. Select the file and click Open .
5. On the next screen select Assigned if it is not already selected.
6. Wait a few seconds until the CCH ProSystem fx Workpaper Manager.msi package displays
under Software Installation. The Workpaper Manager package has now been assigned to all the
computers that were selected earlier.
Wait a few minutes and then reboot all computers that were selected for installation.
CCH ProSystem fx Workpaper Manager will be installed automatically on these machines at
start-up; a screen will display showing the message "Installing managed software
CCH ProSystem fx Workpaper Manager."
If you have a previous version of Workpaper Manager installed on any of these computers and
you are upgrading, all Workpaper Manager modules will be upgraded simultaneously. In
addition, SQL databases will be converted by the Workpaper Manager upgrade installation.
Converting Trial Balances is a separate process. Please see the CCH ProSystem fx
Workpaper Manager Conversion Guide for additional details.
If no prior version of Workpaper Manager exists on a computer, then ONLY the SQL Express®
instance and Workpaper Manager Workpaper Management module (including Trial Balance)
will be installed.
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Appendix E

TECHNICAL CONSIDERATIONS
Appendi x E: T echni cal Consi derati ons

General Program Information
Computer Names
CCH ProSystem fx Workpaper Manager relies on the NetBIOS computer name for most of the
internal program communications.
NetBIOS requires computer names to be a maximum of 15 characters.
It is strongly recommended you do not rename your computer, for any reason, after installing
the SQL instance for CCH ProSystem fx Workpaper Manager.
Doing so may cause serious issues in the program.
If you have renamed or modified the computer name after Workpaper Manager is
installed and are experiencing issues, contact Technical Support at 1-866-513-2677.
Due to possible data loss and installation issues and serious issues with the program, imaging
machines with Workpaper Manager and the SQL instance for Workpaper Manager already
installed is not supported.

TCP/IP
CCH ProSystem fx Workpaper Manager and SQL rely on TCP/IP for network and system
connections.
Internet Protocol v4 (IPv4) is supported.
Internet Protocol v6 (IPv6) is supported.

Note : Server and client machines must have a common version of the Internet Protocol available
in order to communicate. They both must have either IPv4 or IPv6 or both versions selected.
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Services
CCH ProSystem fx Workpaper Manager uses four services for communication between the local file
rooms and the office servers as well as between the office servers. The services are as follows:
SQL Server® (PROFXENGAGEMENT)
PFXEngDesktopService
PFXSYNPFTService
P2EWinService
Pfx.Engagement.SocketService

Note : PfxPDFConvertService.exe is also running in the background and is started at the startup
of the machine. This executable handles CCH ProSystem fx Workpaper Manager PDF printing.

SQL
This service is the SQL data engine that is used to drive the CCH ProSystem fx Workpaper Manager
database. SQL runs as a service, “SQL Server® (PROFXENGAGEMENT),” using a Local System
account that requires full security rights. In CCH ProSystem fx Workpaper Manager this service will
transfer data from workstation database to server database, server database to server database and
workstation database to workstation database over TCP/IP.
If for any reason the SQL Server® (PROFXENGAGEMENT) service is not running, both the
Administrator and Client modules will stop working and the users will be instructed to close the
program. By default this service will start up when the computer starts and remain on until it is either
manually stopped or the computer is shut down.
The SQL Server® (PROFXENGAGEMENT) service is a memory intensive service that will utilize as
much memory as is available to complete the requests it receives. The memory will be released back
to the system as the computer needs the memory for another process. We recommend that you
reboot your workstation daily in order to free up any memory that is being accessed but not used.
Installing additional memory may also improve performance.
For servers where the Admin module is installed, we recommend that you develop a schedule where
you restart the SQL Server® (PROFXENGAGEMENT) service so it will release the memory.

PFXEngDesktopService.exe
This is the service that CCH ProSystem fx Workpaper Manager uses to initiate a refresh of the
remote Workpaper Management or Administrator module. This service interacts with the desktop of
the workstation or server it is running on. Because the service interacts with the desktop, the service
runs under the system account and cannot be changed without rendering the service ineffective.

PFXSYNPFTService.exe
This service is used to copy or move the workpapers from the LFR to the CFR, from CFR to CFR or
from LFR to LFR. This service runs under the system account by default but can be changed as
needed. If you store your workpapers on a location other than the server where the Administrator
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Module is installed, you will need to change the user account to a user that has access to that
location.
For more information, please see the Workpaper Location User Rights section.

P2EWinService.exe
This service is used to copy workpapers from CCH Axcess Portal to CCH ProSystem fx
Workpaper Manager.

Ports
CCH ProSystem fx Workpaper Manager transfers data over the following ports:
SQL Server® (PROFXENGAGEMENT) – TCP port 2029; UDP port 1434
PFXSYNPFTService - TCP port 6735
PFXEngDesktopService - TCP port 6736
PfxConfigUtility – UDP port 6737
P2EWinService - TCP ports 943 and 4530
Pfx.Engagement.SocketService.exe - TCP port 4531
These ports are configured on the server and workstations during installation. However, if you are
connecting over a VPN or through a firewall, or another device such as a router, you will need to
ensure that these ports are opened in order for the program to work correctly.

Other SQL Applications
If you are installing CCH ProSystem fx Workpaper Manager on a computer which currently has an
application using SQL as its database engine, you must stop the SQL service before installing
CCH ProSystem fx Workpaper Manager. When upgrading or reinstalling CCH ProSystem fx
Workpaper Manager, stop all other SQL services before upgrading but leave the SQL Server®
(PROFXENGAGEMENT) service running.

Important: Failure to do this may cause one or both of the applications to fail.

Installation in a Non-Windows® Environment (Linux®)
CCH ProSystem fx Workpaper Manager utilizes the Microsoft ® SQL database architecture; however,
Workpaper Manager is compatible with Non-Windows® networks, including Linux®, with one
additional requirement: the SQL database engine application and database files must reside on a
Windows® computer and must be visible to the Non-Windows® network. All workpapers, (Central File
Rooms), may be stored on the Non-Windows® file server.
There are a few specific steps which need to take place in order to ensure proper communication
between the local file rooms and the available central file rooms. The following procedures will assist
you in the setup process:
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Requirement
The SQL database engine requires a computer with a Windows®-based operating system (Windows
Server® 2012, Windows Server® 2012 R2, Windows Server® 2016, Windows® 7, Windows® 8.1, or
Windows®10). The computer must meet the minimum requirements set forth in the User Guide or
posted on the Workpaper Manager Support Web site. This computer will be used to house the
Workpaper Manager office server and SQL databases.

Procedures
1. Read the installation instructions in this document.
2. On the Non-Windows® server, you will need to create a folder that will store the central file room
workpapers.
3. Install CCH ProSystem fx Workpaper Manager Administrator to the Windows® computer
defined above.
4. Log in and set up this machine as an office server.
5. Follow the steps defined below under Workpaper Location User Rights to set up the
synchronization service to run as needed for this configuration.
6. Create a central file room. When selecting the Location of central file room workpapers,
browse to the folder created on the Non-Windows® server in Step 2.
7. On a separate workstation, install CCH ProSystem fx Workpaper Manager Workpaper
Management module.
8. Log in to the Workpaper Management module and follow the prompts as they appear.
9. Once you have successfully logged in, test the above by synchronizing a binder to/from a central
file room on the Non-Windows® server.

Other Information
User Rights
The installation process sets the Workpaper Manager folder permissions automatically. These rights
are needed for Workpaper Manager to function optimally. The installation gives the “Users” group all
rights except Full Control. These rights are inherited by all child objects so that all folders and
subfolders within Workpaper Manager receive these same rights.

Admin Share Folder
For logging purposes, the Administrator module writes to X:\Pfx Engagement\Admin\Admin Share.
Please note that the program will still work (Administrator actions may still be performed) even if the
system cannot write to the log files. For logging and troubleshooting purposes, we strongly
recommend that Admin users be given rights to this folder, which will allow the system to properly log
all Administrator actions.
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Domain Controllers
Due to issues with Admin Synch failures and transferring Transition Binder Packages between Office
Servers, we do not support installing the CCH ProSystem fx Workpaper Manager Administrator
module on a Domain Controller. Additionally, installing the Workpaper Manager Administrator module
on a Domain Controller puts the server into the role of being a database and file server. If the Domain
Controller goes down, the Admin module and central file rooms will not be available. Our
recommendation is to use a separate server for the Admin Module.

Note : Microsoft ® does not recommend installing SQL Server® on a Domain Controller. See the
following:
http://msdn.microsoft.com/en-us/library/ms143506.aspx#DC_Support
http://msdn.microsoft.com/en-us/library/ms144228(v=sql.100).aspx
http://msdn.microsoft.com/en-us/library/ms144228(v=sql.105).aspx

Macro Security Settings Requirements for Excel® and Word Addins
If the Very High macro security setting is selected in Excel® or Word, the macros required for the
Workpaper Manager addins will not function. We recommend setting the macro security to a setting
that is lower than Very High.

Workpaper Location User Rights
CCH ProSystem fx Workpaper Manager utilizes a service to transfer the workpapers from the LFR to
the CFR that does not require the user to have rights to the CFR location.
The service is called PFXSYNPFTService.exe, referred to as the Pfx sync service. The Pfx sync
service works by emulating File Transfer Protocol (FTP) and therefore only requires that the service
itself have rights to the destination location. By default, the service runs under the Local System
Account, which has full access to the local computer. However, if the workpaper location of the CFR is
stored on another machine, the service will need to be configured to run under a user account that has
Full Control rights to the destination location of the workpapers folder.
The first step in this process is to create a user on each server that has rights to all Workpaper
Manager-related directories and folders. Once you have a user on each server you will need to make
the following modification on the office server (the server where the database files are located):

1. Open Administrative Tools from the Control Panel and select Services.
2. Once Services is open, find the PFXSYNPFTService listed in the Name column.
3. Right click on the Service and select Stop .
4. Right click on the Service and select Properties.
5. Click on the Log On tab.
6. Select the This Account radio button and then click Browse .
7. A dialog will appear that will allow you to browse for a user. Select the user you previously
created for this process.
8. Once you have selected the user and clicked OK, you will return to the Log On screen.
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9. Click Apply. You will be prompted that the user has been granted Login privileges.
10. Click OK.
11. Click OK to close the Properties dialog.
12. Right click on the Service and select Start.

Workpaper Location User Rights for Shared File Room
The Shared File Room is an alternate way of using Workpaper Manager, where users are allowed to
directly access the Local File Room of another user. Using this method, one machine is designated as
the “Host” of the Shared File Room, while all other users are designated as “Remote” users. The Host
and Remote users are allowed to access the Host Local File Room, and can open binders and
workpapers from this shared location.
The Workpaper Manager Shared File Room is completely dependent on Windows® file sharing to
function. Therefore, it is important that the Host user have proper rights to share folders on the
Workstation. This requires at least Power User rights on the machine.
The Windows® file share requires remote users to authenticate to the Host machine. Local user
account will need to be added to the Host machine to allow the remote users to access the Shared
File Room.
Please see the CCH ProSystem fx Workpaper Manager Shared File Room Guide available for
download from the CCH ProSystem fx Workpaper Manager Web site for details on this feature.

Time Synchronization
Time synchronization is an integral part of CCH ProSystem fx Workpaper Manager. Time
synchronization is used to ensure that the latest changes in your binders are processed correctly
during synchronization. Ensuring that servers and workstations running Workpaper Manager are
synchronized for time will help ensure that you do not lose data and that the latest changes to the
data and the server are kept.
To ensure time synchronization, CCH ProSystem fx Workpaper Manager encourages you to utilize
LAN based time synchronization software.

Important: Time synchronization needs to take place on the network. Tools such as the “NET
TIME” command allow you choose a computer on the network to synchronize your clock with. We
DO NOT recommend having your users synch with time servers on the internet as each server
could possibly be several seconds off.

Citrix®/Terminal Services - Shared File Room
Due to file locking issues with Shared File Room, we do not support having two users log into the
same WM profile (using the same login ID) at the same time via Citrix® or Terminal Services.
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ISA (Internet Security and Acceleration) Server Connection Settings
Synchronization failures occurring on large binders may be caused by the number of connections the
ISA server allows per client. It may be necessary to remove the per client connection limit in order to
successfully synchronize these binders. In the Connection Limit dialog, the “Limit the number of
connections” setting should be unchecked.

Supported Microsoft® Windows® Operating Systems and Windows® Servers®
The Microsoft ® Windows® 7, Windows® 8.1, and Windows® 10 Operating Systems are supported.
Only Enterprise, Business, and Ultimate Editions are supported for use with CCH ProSystem fx
Workpaper Manager.
These Operating Systems add new security features, including User Account Control (UAC) and
BitLocker. Workpaper Manager will install and function with the UAC feature turned on. The
installation process requires a system administrator, which is also required with all other operating
systems currently supported by Workpaper Manager. BitLocker encryption is supported when used
with Workpaper Manager.

Notes:
BitLocker is only available on Windows® 7 Enterprise and Ultimate Editions, Windows® 8.1,
Server 2012 and Server 2016.
User Account Control (UAC) is also included with Windows Server® 2012, and Windows Server®
2012 R2 and Windows Server® 2016.
Windows Server® 2012, Windows Server® 2012 R2, and Windows Server® 2016 are supported.

CCH ProSystem fx Workpaper Manager Database Backup &
Restore Utility
For instructions on using the CCH ProSystem fx Workpaper Manager Database Backup & Restore
Utility, refer to Appendix F: Database Backup and Restore on page 77.

Third Party Backup and Restore Processes
If you are currently using a third party backup software to back up the Workpaper Manager databases,
you will not be able to restore a single binder to the central file room. The CCH ProSystem fx
Workpaper Manager Database Backup & Restore Utility allows the restoration of a single binder or an
entire central file room. For additional information, refer to Appendix F: Database Backup and
Restore on page 77.
If you are using the differential backup option in the CCH ProSystem fx Workpaper Manager
Database Backup & Restore Utility, when full backups are performed on a database using a third-party
backup software, the differential backup will be impacted. Any databases that were backed up using
the third-party software will then also be backed up in full as part of the differential backup, which will
increase the size of the differential backup file.
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If you choose to use a third party backup and restore process, there may be some additional
requirements that need to be considered. Refer to the "Frequently Asked Questions" section on the
Support Web site.

Name Resolution - Connecting to Workpaper Manager
CCH ProSystem fx Workpaper Manager uses SQL as the database engine. SQL connects from the
desktops to the server using the TCP/IP protocol. Workpaper Manager is utilizing SQL browsing to
enable the client to see the server or to enable one server to see another. When you first launch
CCH ProSystem fx Workpaper Manager Workpaper Management you are asked to select an office
server to connect to. A list of servers is made available to you to choose from. However, in some
cases, depending on the network type and setup you may not see the server that you are looking for.
This can also happen when you are trying to connect to another Workpaper Management install when
in field mode.
The primary cause of this is the network not being able to resolve the NetBIOS name of the
workstations and servers across networks. These networks include Virtual LANs, Subnets or WANs.
The four methods listed below may be used to alleviate this issue:
Setting up a DNS server (preferred)
Creating and using HOSTS and LMHOSTS files
Setting up a WINS server
Using the CCH ProSystem fx Workpaper Manager Configuration Utility
For further details on the methods listed above, obtain the Microsoft ® documentation necessary, or
contact your system administrator for assistance.

Microsoft® Word and Gridlines with OLE Links
Microsoft ® has confirmed there is an issue with MS® Word when printing the gridlines in Word
(*.docx) for a linked Excel® Object. The gridlines do not print properly with subsequent printing. In
order to work around this issue, you can open the Excel® file and go to the Page Layout tab. In the
Sheet Options group, uncheck the View option for Gridlines. Alternatively, if the file is saved in the
.doc file format, the issue will not present itself. For more information, please refer to
http://support.microsoft.com/kb/2616546.

Support
If you need more information or further assistance with any of the items above, please contact
Technical Support.
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Appendix F

DATABASE BACKUP AND RESTORE
Appendi x F : Database Backup and Restore

Database Backup and Restore
Overview
CCH ProSystem fx Workpaper Manager utilizes the SQL database engine.
This utility has been created to aid administrators in the backup and restore process for the
CCH ProSystem fx Workpaper Manager CentralAdmin, Trial Balance, and bin databases. Please
note that the SQL databases used for Workpaper Manager may not be backed up using your standard
backup procedures. Because direct access to the databases is required, you must either use this utility
to back up the database files, or use a SQL Agent available from your third party backup software
vendor.
This utility is designed for backup and restore of the CentralAdmin database, TB databases and all bin
databases for a single main or secondary office server. This utility will need to be run separately on
each Office Server in your CCH ProSystem fx Workpaper Manager environment.

Important:
To restore a single deleted binder to a Central File Room you must use the CCH ProSystem fx
Workpaper Manager Database Backup & Restore Utility. Your third party backup and restore
software is unable to restore a single binder that has been deleted from the Central File Room.
It is imperative that the firm’s backup processes be tested to ensure proper backups are taken
and that they can be restored. The backup processes should be tested upon the initial setup and
periodically to ensure that the backup can be restored in the event of a failure.

Note : In the event that a Trial Balance needs to be restored, use the option to restore a single
binder. The workpapers folder for the binder will also need to be restored.
The Database Backup & Restore Utility is also the best tool to assist you in migrating the
CCH ProSystem fx Workpaper Manager Administrator module from one server to another.
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Backup Considerations
This utility will create a single backup file that contains the backup of all office server databases. If you
installed CCH ProSystem fx Workpaper Manager to the default installation path, the database files
that will be backed up are located in the following directories: X:\Pfx Engagement\Admin\Data and
X:\Pfx Engagement\TB\Data.

Note : Due to including the TB database in the backup process, the storage space for the
database and the time to complete the backup have increased. The .bak files created by the
backup may be twice the size of those in prior versions of Workpaper Manager. The time required
to complete the process could also be twice as long.
If a failure occurs while backing up a specific database and the database cannot be backed up, that
database will be skipped and this information will be reported in a log file. The log file will be located
in the same directory as the BackupRestoreUtil.exe with the default name of FAILED LogFileForBRMMDDYYYY – HH MM SS. The backup process will continue after such a failure occurs
to ensure the remaining databases are properly backed up. Should a failure occur with a specific
database or binder during the restore process, please contact Workpaper Manager Customer
Support.
Consider the information in the following sections when performing database backup.

Additional Files to Be Backed Up
To ensure a complete backup, the files in the following folders will need to be backed up separately
using your current backup methods. The files stored in these folders are not included in the backup
that is generated by the CCH ProSystem fx Workpaper Manager Database Backup & Restore Utility.
Workpapers folder
Admin Packages folder
Archive folder
Transition Binder Packages folder

Important:
To ensure 100% consistency between the SQL database backup and the Workpaper Manager
Workpaper folder backup, it is recommended to perform each backup within the same window
of time when no changes are occurring on the office server.
If you are not able to prevent all users from accessing the office server during the backups, then
the optimal approach will be to run the backups consecutively to minimize the chance of
inconsistencies. If you are performing snapshot backups of the Workpaper Manager Workpaper
folders on a regular basis and if it can be scheduled to run under Windows®Task Scheduler,
then it is recommended to add your snapshot backup as a 2nd step to the Windows® scheduled
task that you have or will create for the Backup Utility, as per section Running the Backup Utility
(Task Scheduler) on page 85.
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Back Up the Database Backup File
In addition to backing up the folders listed above with your current backup methods, be sure to also
back up the database backup (.bak) file. If you choose to store your backup files on the server where
the Admin module is installed, the backup files should be kept on a different drive. In addition, if you
are performing differential backups as part of your backup strategy, you should be sure to backup both
the differential database backup file as well as the full database backup file that was the base for the
differential backup.

Disable Synchronization
We highly recommend you disable admin and binder synchronization before beginning the backup
process to ensure that the databases and workpapers contain identical information. During the time of
the backup process, synchronization will not be allowed. Users attempting to synchronize during this
time will receive an error.

Close CCH ProSystem fx Workpaper Manager Administrator
To run the Database Backup & Restore Utility, you must first close CCH ProSystem fx
Workpaper Manager Administrator.

Differential Backups
If performing full backups nightly is time consuming, and the files are taking up too much space, then
you may optionally choose to perform differential backups. A differential backup is based on the latest
full backup of the data, which is also known as the base of the differential or differential base.
A differential backup contains only the data that has changed since the differential base. Typically,
differential backups that are taken fairly soon after the base backup are smaller and faster to crease
than the full backup. Usually a differential base is used by several successive differential backups.
Over time, as a database is updated, the amount of data that is included in the differential backup
increases. This makes the backup slower to create and to restore. Eventually, another full backup
must be created to provide a new differential base for another series of differential backups. At restore
time, you will need both the full backup file and the latest differential backup file.

Notes:
When a database reaches 2.5 GB in size, a new database is created. If a new database is
created after the full backup, then a full backup of this database will be completed as part of the
differential database backup until the next full backup of all databases using the utility.
When a full backup is performed on a database using a third party backup software after the full
backup has been completed using the CCH ProSystem fx Workpaper Manager Database
Backup & Restore Utility, then a full backup of this database will also be completed as part of
the utility's differential backup until the next full backup of all databases using the utility.
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Running the Backup Utility (User Interface)
To run the Backup Utility in the user interface, do the following:

1. Launch the Database Backup & Restore Wizard by doing one of the following:
Select Start > Programs > CCH ProSystem fx Workpaper Manager > Utilities >
CCH ProSystem fx Workpaper Manager Database Backup & Restore Utility.
In Windows® Explorer, browse to the X:\Pfx Engagement\Admin\Utilities\Backup
Restore folder and double-click BackupRestoreUtil.exe .

2. Click Next on the Welcome dialog.
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3. After you have read and understand the information regarding backup, check the box and click
Next.

4. Select Backup .
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Note : If you have already completed a full backup and now want to perform a differential
backup, select Backup and check the Differential box.

5. Provide the location where the files are to be stored by clicking Browse . The selected location
must be on a local drive/directory or a mapped network drive. If you select a mapped network
drive, the user account under which the SQL Server® service is running must have credentials to
write to that mapped network location.
6. Click Next.
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7. Review the backup settings and click Back Up to begin the backup process.

A progress indicator page will display to show you the progress of the backup.

Once complete, the Completing the CCH Pfx Workpaper Manager Database Backup and
Restore Wizard page will display the number of databases that were successfully backed up
and the number that failed to be backed up.
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8. Click View Log to view a log detailing the backup information for each database.
9. Click Finish to exit the wizard.

Notes:
At the end of the process, only one .bak file will be created. This single file will contain
the backups for all of the Office Server databases. The default name for the backup file
is Office Server Name_Full MMDDYYYY HH MM SS.bak.
If your backup strategy includes differential backups, remember that you will need two
backup files to restore the data: the differential backup file you want to restore and the
full backup file that was the base for the differential backup.
If a new bin is created as part of the bin maintenance in Workpaper Manager, after the
latest full backup, when the differential backup is performed, the new database will be
backed up in full as part of that backup.
If one or more databases are backed in full using a third-party tool after the latest full
backup completed with the utility, then those databases will be backed up in full as part
of the differential backup performed by the utility.
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Running the Backup Utility (Task Scheduler)
The following instructions assume you have agreed to the warning in step 3 above in the User
Interface section.

Note : The following instructions are for Server 2008. Other supported operating systems have
similar task scheduling options.
To run the Backup Utility using Task Scheduler, do the following:

1. Open Task Scheduler.
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2. Select Create Task.

Note : If you will be running differential backups, you should set up two scheduled
tasks: one for the full backup, and another for the differential backup. When setting up the
task for the differential backup, steps 5 and 7 will differ slightly.

3. Create a task named BackupRestoreUtil on the General tab of the Create Task Wizard screen.
a. Verify that the task is set to run as an Administrator of the server.
b. Choose Run whether user is logged on or not.
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c. Choose Run with highest privileges.

4. Go to the Triggers tab and click New.
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5. On the New Trigger screen, set the desired schedule for the backup task to run and click OK.

Note : If you will be running differential backups, the settings for the trigger should be a little
different for the full backup task and the differential backup task.
6. Select the Actions tab and click New.
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7. On the New Action screen, verify the Action is set to Start a program.
a. Click Browse and navigate to X:\Pfx Engagement\ADMIN\Utilities\Backup
Restore\BackupRestoreUtil.exe (where X represents the drive where the program is
installed).
Notes:
If the save location for the backup files is to be on a different machine, the path to
the share must be a UNC path.
Also, the SQL Server® (PROFXENGAGEMENT) service must be set to run as an
account that has full control rights to the shared location.

b. In the Add arguments (optional) field, add the /f switch and the path information for the
desired location to save the backup files. The path should include quotation marks if
there are any spaces in the name.
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Notes:
The command line parameter /f must be entered in lowercase. Using an
uppercase F will result in an incomplete backup.
If you are using the Task Scheduler for a differential backup, you should add the
/d switch and path information for the desired location to save the backup files in
the Add arguments (optional) field instead of /f.
The path should include quotation marks (" ") if there are any spaces in the name.

c. Click OK to save the information.
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8. Verify that the settings on the Conditions and Settings tabs are set to meet your needs.

9. Click OK to save the information.
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10. Provide the credentials for the account that the scheduled task is to run as.

11. The BackupRestoreUtil will appear listed in the Task Scheduler Library.

Appendix F: Database Backup and Restore • 92

Restore Considerations
Restore is a critical part of the disaster recovery process. Due to the nature of the application and the
fact that the application document control relies on the database to ensure workpaper integrity, very
specific restore procedures must be followed.

Notes:
While the restore process can be performed on your own, we strongly recommend you contact
Workpaper Manager Customer Support before attempting to restore any data.
When backing up to a network location, a user with rights to both the local computer and the
network location must start the SQL instance.
When restoring, ensure Windows® Updates or Windows® Module Installer Worker Service are
not running. You may experience slow performance or errors if either of these are running in the
background.
If a failure occurs while restoring a specific database or binder, that database/binder will be skipped
and this information will be reported in a log file. The log file will be located in the same directory as
the BackupRestoreUtil.exe with the default name of LogFileForBRMMDDYYYY – HH MM SS.txt.
The restore process will continue after such a failure occurs to ensure the remaining databases or
binders are properly restored. Should a failure occur with a specific database or binder during the
restore process, please contact Workpaper Manager Customer Support.
The following should also be considered when restoring databases or binders:

Additional Files to Be Restored
This utility will restore the office server bin databases and the CentralAdmin database contained
within the selected backup file. If selected, the utility can restore individual binder database
information only. It will NOT restore the central file room workpapers or other files that were backed
up separately. Those files must be restored separately.
To ensure a complete restore, the files in the following folders will need to be restored separately
using your current restore methods. The files stored in these folders are not included in the backup
that is generated by the CCH ProSystem fx Workpaper Manager Database Backup & Restore Utility.
Workpapers folder
Admin Packages folder
Archive folder
Transition Binder Packages folder

Important: It is imperative that the workpapers and SQL databases are restored and completed
together and that no changes occur to either during the restore. When restoring individual binder
database information, do not restore the workpapers for all binders in the database. Restore only
the workpapers for the individual binder database information being restored.

Appendix F: Database Backup and Restore • 93

Disable Synchronization
We highly recommend you disable admin and binder synchronization before beginning the restore
process. During the time of the restore process, synchronization will not be allowed. Users attempting
to synchronize during this time will receive an error.

Review Administrative Changes Since Last Backup
When restoring from backup, be aware that administrative changes may have occurred since this
backup took place. If any of the following changes occurred since this backup, please contact
Workpaper Manager Customer Support for assistance.
Create or delete central file room
Add, remove or reassign licenses
Change workpaper location
Workpapers checked in/out
Add or remove staff members
New binders synchronized to central file rooms

Close CCH ProSystem fx Workpaper Manager Administrator
To run the Database Backup & Restore Utility, you must first close CCH ProSystem fx
Workpaper Manager Administrator.

Restoring from a Differential Backup File
If you have chosen to perform differential backups as part of your backup strategy, you will need two
backup files at restore time: the differential backup file that you want to restore and the full backup file
that was the base for the selected differential backup (or the differential base).

Running the Restore Utility (Restore All Office Server Databases)
To restore all office server databases, do the following:

1. Launch the Database Backup & Restore Wizard by doing one of the following:
Select Start > Programs > CCH ProSystem fx Workpaper Manager >

CCH ProSystem fx Workpaper Manager Database Backup & Restore Utility.
In Windows® Explorer, browse to the X:\Pfx Engagement\Admin\Utilities\Backup
Restore folder and double-click BackupRestoreUtil.exe .
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2. Click Next on the Welcome page.

3. After you have read and understand the information regarding restore, check the box and click
Next.
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4. Select Restore . Browse for the backup file [.bak] to be restored. The Office Server databases
within the selected backup file will display in the list.

Note : If the backup file selected is a differential backup, then you will also have to select
the full backup file that was the base for the selected differential backup. A second text field
and Browse button will be displayed allowing you to browse for the full backup file [.bak].

5. Click Next.
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6. Review the restore settings and click Restore .

A progress indicator page displays the progress of the restore.

Once complete, the Database Backup & Restore Wizard Complete page will display the number
of databases that were successfully restored and the number that failed to be restored.

7. Click View Log to view a log detailing the restore information for each database.
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8. Click Finish to exit the wizard.

Running the Restore Utility (Restore Individual Binder Database
Information)
To restore individual binder database information, do the following:

Note : Due to the number of databases now included with Workpaper Manager, the restoration
process for individual binders can take a long time to complete.
1. Launch the Database Backup & Restore Wizard by doing one of the following:
Select Start > Programs > CCH ProSystem fx Workpaper Manager >

CCH ProSystem fx Workpaper Manager Database Backup & Restore Utility.
In Windows® Explorer, browse to the X:\Pfx Engagement\Admin\Utilities\Backup
Restore folder and double-click BackupRestoreUtil.exe .
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2. Click Next on the Welcome page.

3. After you have read and understand the information regarding restore, check the box and click
Next.
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4. Select Restore and check the Binders only box.

5. Browse for the backup file [.bak] from which to restore the binder database information. The
Office Server databases within the selected backup file will display in the list.
Note : If the backup file selected is a differential backup, then you will also have to select
the full backup file that was the base for the selected differential backup. A second text field
and Browse button will be displayed allowing you to browse for the full backup file [.bak].
6. Click Next.
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7. Highlight the individual binder to be restored. To select multiple binders to restore, use the Ctrl
or Shift key while highlighting the binders, or click the Select All button.

8. Click Next.
9. Review the restore settings and click Restore .
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A progress indicator page displays the progress of the restore.

Once complete, the Completing the CCH Pfx Workpaper Manager Database Backup and
Restore Wizard page will display the number of binders where the database information was
successfully restored and the number that failed to be restored.

10. Click View Log to view a log detailing the restore information for each binder.
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11. Click Finish to exit the wizard.

Note : If users synchronized trial balance or Knowledge Coach data to the office server while the
SQL databases were being backed up, the data will be included in the next backup that occurs.
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